2017-2018
Fellows’ Reference Guide
Infectious Diseases Service
VA St. Louis Health Care System
# Table of Contents

**Getting Started**  
1. Parking  
2. Fellows’ Office and ID Offices  
3. Phones and Pagers  
4. Badges (PIV Cards)  
5. Computer Access and Email  
6. Food  

**Objectives**  
7. 

**Teaching Methods**  
8. 

**Inpatient Consult Service**  
9. ID Daily Lists  
10. Receiving New Consults  
11. Inpatient HIV Patients  
12. Arranging Outpatient Follow-Up  
13. Weekend Coverage  

**Electronic Consultation (eConsults)**  
14. 

**Outpatient Clinic**  
15. 

**Outpatient Parenteral Antibiotic Therapy (OPAT)**  
16. JC Inpatients  
17. Outside Hospital Inpatients  
18. Outpatients  

**Antibiotic Approval**  
19. 

**Patient Phone Calls**  
20. 

**How to Write a Note in CPRS**  
21. 

**How to Do Encounters in CPRS**  
22. 

**Finding Stuff in CPRS and Elsewhere**  
23. 

**Important Contacts**  
24. 

**Web Resources**  
25. 

**Map of John Cochran Hospital**  
26.
GETTING STARTED

Welcome to the Infectious Diseases Section at the VA St Louis Health Care System. In this manual are the objectives of the rotation and useful information relevant to organization and day-to-day functioning of the VA ID consultation service. Though we’ve made every effort to cover the basics, please don’t hesitate to ask if you have any questions as you go through your rotation – we’re a generally friendly bunch! And let us know if you have suggestions for updates to next year’s Fellows’ Manual.

Dr. Abigail Carlson is the site director for the VA Infectious Diseases Fellowship rotations. You can contact her at any time if you have questions or concerns regarding your VA rotation. (See contacts list on page 29)

The VA St. Louis has two Divisions – John Cochran (JC) on N. Grand Blvd., which is the acute care hospital, and Jefferson Barracks (JB) in South County, which houses the rehabilitation and long-term care facilities, along with a number of outpatient services. Basic laboratory and radiology work can often be done at JB if patients prefer. There are also several community outpatient clinics, called CBOCs (Community Based Outpatient Centers). We are the ID service for all of these sites, thus you may receive calls from staff at any one of these facilities. However, patients are only seen in person by ID at John Cochran.

Within the VA St. Louis “Orbit”, there are two other health care systems: the Marion VA and the Poplar Bluff VA. These VAs do not have full time infectious diseases physicians, thus we often serve as the ID point of contact. If you have patients from the Marion or Poplar Bluff VA and you are trying to arrange for services at those sites, speak with your attending and/or the ID pharmacists, as the procedures are often different from those outlined in this book.

Parking
Parking passes will be obtained during orientation. If you have issues with your pass or access to the lot, see the Parking Office on the 9th floor to the right of the Building A Elevators.

As you will discover, parking at the VA can be challenging. The closest lots to the hospital are often full. Most of the street spots around the hospital are metered, so street parking is limited. Below are two maps of the official lots of the VA. In addition, there is some non-metered street parking to the west of the hospital on Enright and Spring Avenues and to the east of the hospital along Franklin Avenue and Josephine Baker Boulevard. Please be mindful that east of the hospital is a residential neighborhood and limit your parking in that area.

The VA is also accessible by Metro (Grand Station). The VA shuttle will pick up and drop off at the Metro along the same schedule as the parking shuttle (approx. q10min during peak hours, q20min during off hours).
Green Star: Ambassador Entrance to the hospital. This is where the shuttle for the Scottish Rite Garage and Metro picks up and drops off. During peak hours (6am-9am, 3pm-6pm), the Scottish Rite shuttle is a large bus with a blue sign that comes approximately every 10 minutes. Off-hours, it is a smaller bus that may or may not have a blue sign and runs every 15-20 minutes. The Metro shuttle is usually always the smaller bus. When in doubt, ask the driver, as there are a lot of shuttles!

Yellow Star: Parking 1 and Parking 2. These lots have very limited physician parking spaces, and Parking 1 requires a PIV card to access. Park only in spots marked “Physician Parking Only”, as you will otherwise be ticketed by the VA police (a federal offence)!

Red Star: Parking 3 and Parking 4. You can park in any open spot in Parking 3. Spots in Parking 4 are limited – park only in spots that are designated for VA employees. Occasionally, Parking 4 is closed to VA employees because of other downtown events, so if you park there, be sure to check your email and make sure it’s open for us that day.

Blue Star: Scottish Rite Garage. There is always a place to park in this garage, so it’s your best bet if you just need to find a spot. Enter by taking a ticket. The shuttle will pick up right at the entrance to the garage, and occasionally across the street at the Women’s Clinic. You should leave the garage by 6pm. Show your ticket to the shuttle driver to get it validated, or just write “VA” on the back. If no one is there to collect your ticket at the end of the day, don’t worry – it happens all the time, you can just drive out.
**Fellows’ Office and ID Offices**
The ID Fellow’s office is located on the 2nd floor back behind the B elevators next to the freight elevator, Room C220. The code for the door is 8642* - if you touch the keypad, the numbers will appear. Computers, phones and a printer are available there.

The ID faculty offices are on the 6th floor of the B building. See the contact list on page 29 for office numbers. The Medicine Office is at the end of the same hallway through the double doors, room B620. There is a fax machine there you can use to send and receive documents. The fax number is 314-289-6389, or 56389 for faxes coming from inside the VA St. Louis.

**Phones and Pagers**
For calling within JC and JB, you can call anyone by the 5-digit extension. To get an outside line, press 9, then dial the number. No special long-distance code is required.

To call the ID pager, dial 5-PAGE (57243) from a VA line. When asked for your “pager number”, dial 1577 (the ID pager). It will then ask for the number you want displayed. Enter your call back number, followed by the pound sign (#). This is true for all pagers that you are trying to reach through the 5-PAGE system – the “pager number” of the service you are trying to call is always entered first NOT your own pager number.

To call into a VA line from outside, dial 314-652-4100. You will hear a 4-note tone, after which you can dial the 5-digit extension. This also works for any pagers that use the 5-PAGE system, just dial 5-PAGE after the tone.

**Badges (i.e. PIV Cards)**
Badges at the VA are called “PIV Cards” and are used to access a variety of things, most importantly your computer! You will receive your badge at orientation, but if you need assistance, you can either check with the PIV office (9th floor, to the right of the A Elevators in the same spot as the Parking Office), or make an appointment at www.va-piv.com. If you need to get fingerprints, get a photo taken, or pick up your badge, you will need to book an appointment first. Always have your PIV with you, as it is very difficult to access your computer without it.

**Computer Access and E-Mail**
You will receive a number of usernames and passwords during orientation, which should allow you to access your computer and CPRS (the electronic medical record), and to sign notes. They are:

- Your Windows Username (starts with “VHASTL”): Logging on to the computer
- Your Windows Password: Logging on to the computer
- Your VistA Access Code: Accessing CPRS
- Your VistA Verify Code: Accessing CPRS
- Your PIN: Logging on to your computer with your PIV and signing notes

**Write all of these down!** You will use them over and over again, and will forget them between every rotation! Also note that accounts are deactivated if not used for 30 days. You will likely need to reactivate your account every time you come back to the VA for a rotation. To do this, email Robert Skinner at Robert.Skinner2@va.gov the week before your rotation, and let him know when you are scheduled to start so he can reactivate you in the system. He is also your point of contact if you need a password reset or are having other computer trouble.
Once you have access to the computer, open Outlook to set up your VA e-mail account. You will not use this often, but occasionally there are important facility-wide announcements or deals on Cardinals tickets and Six Flags passes. More importantly, you can e-mail patient information securely within the VA by clicking on “Encrypt” in the “Options” tab of an e-mail. To access encrypted e-mails that are sent to you, type in your PIN when prompted. If this is not working, talk to Robert Skinner about getting encryption permissions.

Remote access/VPN for the VA system is available. However, most fellows choose not to get remote access set up, as it is usually not necessary during their rotation. If you would like to have remote access, let Dr. Carlson know, and she can assist you in arranging this.

Food
The main cafeteria is located on the 3rd floor and is open daily 7am-3pm Monday-Friday. The VCS Retail Store is also on the 3rd floor, next to the cafeteria. They have drinks, snacks, sandwiches, candy, and a variety of odds and ends. They are open 7am-4:30pm Monday-Friday and 7:30am-1:30pm on Saturday. There is also a coffee shop on the first floor at the main entrance that is open 7am-4:30pm Monday-Friday.

Objectives
The main objective for the Infectious Diseases Inpatient Consultation Service is to understand the basic principles of the etiology, pathophysiology, clinical manifestations, epidemiology, diagnosis, complications, and therapy of infectious diseases in the context of the Veteran patient population and integrated healthcare system environment.

Fellows and residents will be expected to focus the major part of their study time researching topics relevant to cases followed by the team in general and their own patients in particular. It is strongly recommended that the resident and fellow cover one objective as a reading assignment several nights per week. The resident may choose to use a major medical textbook such as Cecil’s or Harrison’s as a source. The MKSAP textbooks and questions are also an excellent resource. The fellow should utilize an infectious diseases textbook such as Mandell or Cohen & Powderly to broaden the scope of their reading. Regular reading of a major infectious diseases journal, such as Lancet Infectious Diseases or Clinical Infectious Diseases is also beneficial. All individuals on the infectious diseases rotation are strongly recommended to do literature searches in order to obtain the most current information pertinent to a particular case. Generic drug names should be used instead of trade names when discussing medications, especially antibiotics (e.g. daptomycin instead of Cubicin).

Inpatient Service Objectives
1. PATIENT CARE:
a. Gather accurate information about patients, including performing a thorough history and physical examination
b. Synthesize data into a prioritized problem list and differential diagnosis, then formulate diagnostic and therapeutic plans
c. Monitor and follow up patients appropriately
d. Prioritize each day’s work (for self and entire team)
e. Communicate plan to referring physicians

2. MEDICAL KNOWLEDGE
   a. General Infectious Diseases
      i. Know the common etiologies, clinical manifestations, complications, diagnosis and therapy of infections of bone and joint, skin and soft tissue, respiratory tract, central nervous system, cardiovascular system, gastrointestinal tract, and genitourinary tract, particularly in the setting of the VA population.
      ii. Be aware of the pathogenesis, etiologies and workup of fever of unknown origin (FUO) in the VA setting.
      iii. Understand the common etiologies, clinical manifestations, diagnostic approach and treatment principles of infection in the immunocompromised host.
      iv. Appreciate the ways in which multiple chronic diseases influence the host response to infectious disease processes.
      v. Know how to recognize, diagnose and manage endovascular infection, endemic and opportunistic mycoses, and infection in the immunocompromised host.
      vi. Become familiar with the use of antimicrobials and aware of their adverse effects and complications.
      vii. Understand the development of resistance to antimicrobial agents.
      viii. Appreciate the principles of infection control and hospital epidemiology.
      ix. Be familiar with the presentation and be able to recognize bioterrorism-related diseases.
      x. Learn to evaluate the primary clinical infectious diseases literature and utilize this literature to implement effective therapeutic measures.
   b. HIV/AIDS Care
      i. Understand the pathogenesis of HIV and its relation to the principles of antiretroviral therapy and long-term outcomes.
      ii. Know the currently approved antiretroviral drugs and how we use them. Be able to recognize and manage antiretroviral adverse effects.
      iii. Learn the most frequent forms of presentation of opportunistic infections and neoplasia that affect HIV positive patients.
      iv. Understand the principles of antiretroviral prophylaxis after exposure to needle stick injuries.
      v. Assess and encourage adherence to antiretroviral therapy.

3. PRACTICE-BASED LEARNING AND IMPROVEMENT
   a. Understand the limitations of one’s knowledge and judgment; ask for help when needed; be self-motivated to acquire knowledge
   b. Accept feedback, learn from own errors and develop self-improvement plans
   c. Use information technology to manage information and access on-line medical information
d. Learn how to apply knowledge of study designs and statistical methods to the critical appraisal of clinical studies and to the care of patients

e. Learn how to effectively find and incorporate up-to-date literature for the management of patients.

4. INTERPERSONAL AND COMMUNICATION SKILLS
   a. Demonstrate caring and respectful behaviors with patients, families, including those who are angry and frustrated; and all members of the health care team.
   b. Counsel and educate patients and their families.
   c. Sensitively discuss new HIV diagnoses, encourage partner notification, and respect patient wishes about disclosure of their diagnosis
   d. Facilitate the learning of students and other health care professionals
   e. Demonstrate ability to convey clinical information accurately and concisely in oral presentation and in CPRS notes
   f. Communicate with referring physicians regularly

5. PROFESSIONALISM
   a. Demonstrate respect, compassion, and integrity
   b. Demonstrate a commitment to excellence and on-going professional development
   c. Demonstrate a commitment to ethical principles pertaining to provision or withholding of clinical care, confidentiality of patient information, informed consent, and other aspects of clinical care
   d. Develop an appreciation for the ethical, cultural and socioeconomic dimensions of illness, demonstrating sensitivity and responsiveness to patients’ culture, age, gender, and disabilities
   e. Display initiative and leadership; be able to delegate responsibility appropriately

6. SYSTEM-BASED PRACTICE
   a. Work effectively with others (such as nurses, secretaries, social workers, nutritionist, physical and occupational therapists, technicians) as a member of a health care team
   b. Work closely with the microbiology laboratory, pathology and pharmacy to facilitate consultations
   c. Advocate for quality patient care and assist patients in dealing with system complexities
   d. Understand and appreciate the importance or contacting the patient’s referring physician as soon as possible
   e. Develop proficiency in organizing and managing consultative care
   f. Learn the cost-effective use of diagnostic and therapeutic technology

Outpatient Service Objectives

All of the Competency Milestones are pertinent to this rotation. Areas of special focus are noted below.

Residents should be able to develop a basic level of competence in the skills listed. Fellows should be able to perform the skills with greater independence and at a more advanced level (e.g., elicit subtle findings, suggest advanced therapeutic courses), in a greater number of patients per clinic shift.
Patient care:
1. Gather accurate information about patients, including performing a thorough history and physical examination.
2. Synthesize data into a prioritized problem list and differential diagnosis, and then formulate diagnostic and therapeutic plans.
3. Monitor and follow up patients appropriately.
4. Communicate plan to referring physicians.

Medical knowledge:

A. HIV/AIDS CARE
   a. Understand and appreciate the impact of HIV and AIDS on human health.
   b. Know the principles of primary care of the HIV infected patient in the VA setting.
   c. Understand the pathogenesis of the HIV infection and its relation to the principles of antiretroviral therapy.
   d. Know the currently approved antiretroviral drugs and how we use them.
   e. Learn the most frequent forms of presentation of opportunistic infections and neoplasia that affect HIV positive patients in the VA setting. Learn their treatment and prophylaxis.
   f. Understand the importance of adherence to antiretroviral treatment and how to improve it.
   g. Understand the principles of antiretroviral prophylaxis after exposure to needle sticks.

B. GENERAL INFECTIOUS DISEASES
   a. Know the clinical manifestations, complications and therapy of bone and joint infection.
   b. Be aware of the pathogenesis, etiologies and workup of fever of unknown origin in the VA community setting.
   c. Become familiar with the outpatient use of antimicrobials and aware of their adverse effects and complications.
   d. Know how to diagnose and manage endovascular infection, endemic and opportunistic mycoses, and infection in the immunocompromised host.

C. PRACTICE-BASED LEARNING AND IMPROVEMENT:
   a. Understand the limitations of one’s knowledge and judgment, ask for help when needed, and be self-motivated to acquire knowledge.
   b. Accept feedback, learn from own errors and develop self-improvement plans.
   c. Use information technology to manage information and access on-line medical information.
   d. Learn how to use knowledge of study designs and statistical methods to the critical appraisal of clinical studies and apply to the care of patients.
   e. Learn how to effectively find and incorporate up-to-date literature for the management of the patients.

D. INTERPERSONAL AND COMMUNICATION SKILLS:
a. Demonstrate caring and respectful behaviors with patients, families, including those who are angry and frustrated, and all members of the health care team.
b. Counsel and educate patients and their families.
c. Sensitively discuss new HIV diagnoses, encourage partner notification, and respect patient wishes about disclosure of their diagnosis.
d. Conduct supportive and respectful discussions of code status and advance directives for patients for whom they are primary care givers.
e. Demonstrate ability to convey clinical information accurately and concisely in oral presentation and in chart notes.
f. Communicate with referring physicians regularly.

E. PROFESSIONALISM:
   a. Demonstrate respect, compassion, and integrity.
   b. Demonstrate a commitment to excellence and on-going professional development.
   c. Demonstrate a commitment to ethical principles pertaining to provision or withholding of clinical care, confidentiality of patient information, informed consent, and other aspects of clinical care.
   d. Develop an appreciation for the ethical, cultural and socioeconomic dimensions of illness, demonstrating sensitivity and responsiveness to patients’ culture, age, gender, and disabilities.
   e. Display initiative and leadership.
   f. Be able to delegate responsibility appropriately.

F. SYSTEMS-BASED PRACTICE:
   a. Work effectively with others (such as nurses, secretaries, social workers, nutritionist, physical and occupational therapists, technicians) as a member of a health care team.
   b. Work closely with the microbiology laboratory, pathology and pharmacy to facilitate consultations.
   c. Advocate for quality patient care and assist patients in dealing with system complexities.
   d. Understand and appreciate the importance or contacting the patient’s referring physician as soon as possible.
   e. Develop proficiency in organizing and managing consultative care.
   f. Learn the cost-effective use of diagnostic and therapeutic technology

TEACHING METHODS

1. Progressive, graduated responsibility for performance of the initial history and physical examination, formulation of diagnostic and therapeutic plans, writing of orders, continued inpatient care under the supervision of attending physicians
2. Daily Bedside Teaching rounds
3. Attendance of VA noon conferences applicable to ID

Education of residents and fellows during the VAMC Infectious Diseases rotation will occur through direct patient evaluation on both outpatient and inpatient basis, formulation of differential diagnoses and management; participating in daily inpatient ID rounds; attending conferences and teaching sessions; independent reading; utilizing the microbiology laboratory; and participating in
didactic sessions. Fellows are expected to continue to attend educational activities at WUSM during their time at the VA, unless these conflict with VA patient care or educational responsibilities.

Suggested Reading lists and Web-based Resources: See attached bibliography and web links for selected readings in both General Infectious Diseases and HIV/AIDS care.

The mix of diseases, patient characteristics, and types of clinical encounters, procedures, and services: Consultations encompass a broad mix of acute infectious disease problems requiring hospitalization, including Veterans of both sexes and a wide range of ages. Patients seen on the outpatient clinical service will have a wide range of acute and chronic infections with a heavy emphasis on HIV/AIDS, including indigent and insured patients, of both sexes and a wide range of ages.

Methods of evaluation of fellow performance:
1. Fellow evaluations are completed electronically by attending physician with verbal feedback to the fellows at the end of the rotation.
2. Evaluation by attending at bedside.

Level of supervision of fellows and residents by faculty members in patient care activities:
1. The attending physician will see all patients on daily rounds.
2. The attending physician will observe the fellows and residents performing specific tasks of patient management such as the interview and physical examination, choice of diagnostic studies, formulation of differential diagnosis or problem lists, development of plans for short-term and long-term medical management, communication of treatment plans, and discharge planning.
3. Feedback to fellows and residents regarding quality of consultation notes.

Interaction with residents on consultation services:
1. Fellows will function as team leaders, teachers and mentors for residents rotating through the ID consult services
2. Fellows will discuss the case with residents prior to presentation at attending rounds.

INPATIENT CONSULT SERVICE

When starting the service, the incoming fellow should obtain the ID pager from the outgoing fellow, usually at Core Curriculum conference on the Wednesday of the switch. The fellows should perform a sign-over of the service as well either that day or the night before.

Service hours are highly variable depending on the case load. However, general hours are 8am-5pm Monday-Friday. Rounding schedules are dependent upon the schedules of the fellow, attending and resident. Most often, the fellow, residents, and ID pharmacy team will round together with the attending once in the late morning or early afternoon. However, check with your ID attending each day to set the day’s rounding time. Also, if you know you have schedule conflicts (such as your continuity clinic), let the attending know as soon as possible (ideally, a few days in advance!) so the rounding schedule can be adjusted accordingly and the attending can make sure they are available.
It is expected that the fellow and resident review and see all old patients and new consults prior to the day’s rounds. If consults come during rounds, the team will often see these patients together, but this will vary by attending and schedule.

Residents must attend their general medicine clinic and dedicated teaching time during their month on Infectious Diseases. Fellows attend their own WU ID clinic as well as the VA ID clinic. It is the responsibility of the resident to round on their ID patients and sign out to the fellow prior leaving for clinic or educational activities.

**ID Daily List**
The list of service patients is kept in a shared folder on the hospital server (Medicine → Infectious Diseases → ID Daily Lists). To access it the first time, you can do the following:

1. In the Start Menu, click on the Computer name (usually starts with “STL”):

   ![Computer Drive](image)

   1. Word 2016
   2. Outlook 2016
   3. Excel 2016
   4. OneNote 2016
   5. PowerPoint 2016

   ![Hard Disk Drives](image)

   1. OS Disk (C):
   2. 131 GB free of 232 GB

   ![Devices with Removable Storage](image)

   1. DVD RW Drive (D:)

   ![Network Location](image)

   1. Services (\15.med.va.gov\15\stl)
   2. VHSTLCARLISA (\15.med.va.gov\15\stl\users)...

   2. This will open your computer drives. Click on the Services drive. If you do not see this drive in your window or do not have access to any of the folders below, contact Robert Skinner (Robert.Skinner2@va.gov).
3. Open the “Medicine” folder, then the “Infectious Diseases” folder. We recommend you create a shortcut to the Infectious Diseases folder for your computer desktop at this time by right-clicking on the Infectious Diseases folder, selecting “Send to…” and then clicking on “Desktop”.

4. In the Infectious Diseases folder, click on “ID Daily Lists”, then select the folder with the appropriate year and month. The day’s list will be found there.

**Receiving New Consults**

Inpatient consults are submitted for patients on the acute care wards at JC. Consults are sent to the ID service electronically in CPRS. When you open CPRS each day, you will see a list of new consults. The inpatient consults are titled “ID INPATIENT JC” - these are your highest priority consults. Referring services are expected to call the fellow to discuss the consult as well, but this does not always happen. Be sure to check the list regularly for new submissions.

Open the consult by double-clicking on it in the list. **Note that once you do this, the consult will disappear from your CPRS list. Be sure to add the patient’s name and information to your ID Daily List before leaving the patient’s chart!** Inpatient consults should ideally be addressed the same day as received, but definitely within 24 hours of the consult being placed. If for any reason a consult cannot be completed within 24 hours, be sure to at least start a note in CPRS for the consult, or add a comment (Consult Tab ➔ Action ➔ Consult Tracking ➔ Receive [if you will see the patient later] or Add Comment [if there is a technical or administrative issue with the consult]). The unsigned note will be saved in CPRS until you can complete it. For instructions on writing a note, see page 20.

**Inpatient HIV Patients**

HIV patients will be admitted under the Medicine Service. Please take a moment to review their inpatient record; especially if patient is on routine cART (errors with inpatient cART prescriptions are common). If you identify new HIV patients in the hospital, provide them with contact information and clinic follow-up before they are discharged.

**Arranging Outpatient Follow-Up**
To arrange outpatient follow-up of patients seen by ID as an inpatient, state in your final progress note the time you wish them to follow up (e.g., “in 3 weeks”, “on September 22\textsuperscript{nd}”). Do not state a range, as the rules do not allow our schedulers to use a range. If you say “3 weeks”, however, the scheduler has the flexibility to schedule any time within 30 days of that week. Once the note is signed by you, add the schedulers as co-signers (Notes Tab → Action → Identify Additional Signers). Courtney Allen and Sherry-Ann Stevenson are currently our ID schedulers, and you can add both as additional signers. We usually have open clinic slots available for urgent cases, but talk to the schedulers directly regarding any patients you want seen in under a week (see contacts list on page 30 for phone numbers).

If a patient has not been seen by ID as an inpatient but needs outpatient follow-up, have the referring service submit an outpatient ID consult. If you wish for a telemedicine appointment instead of a clinic appointment, state this in the note. These are available for patients at JB who have significant difficulty with mobility, particularly in the Spinal Cord Injury unit. Sometimes, we are able to do telemedicine visits with Poplar Bluff and Marion patients as well. Ask your attending about arranging telemedicine visits for these patients.

**Weekend Coverage**

Fellows will be on call most Saturdays at the VA, and the ID attending will often choose to round over the phone. The schedule is flexible, but discuss with your attending their availability for phone rounds. The majority of consults should be called by noon, but there are exceptions.

From 8AM Sunday through 8AM Monday, the fellow is off call. The fellow pager should be turned off. The ID attending will be the first call during that time and will round on old and new patients. If you receive calls regarding new consults after rounds on Saturday, be sure to let the ID attending know so they can staff them on Sunday.

During the year, each fellow has one “golden weekend” where they are off both days and one “black weekend” where they are on both days at the VA. Each attending deals with these differently, so let your attending know when your golden and black weekends are scheduled. The ID attending will cover both Saturday and Sunday on the golden weekends.

**Electronic Consultation (EConsults)**

The VA has a system of electronic consultation that is used when the referring provider has a question for the consulting service but in-person consultation is not felt to be necessary. These consults involve chart review only. Electronic consults will also show up in your CPRS list just like inpatient consults do, but are titled as “INFECTION DISEASES ECONSULT”.

EConsults should be responded to within 24 hours, as we would with inpatient consults. EConsults are usually staffed on rounds with the inpatient ID attending. Some eConsults that are submitted are for inpatients, particularly from the Marion and Poplar Bluff VAs. If, in your CPRS list, there is an entry under “Location” next to the patient’s name, this means the patient is likely admitted at a VA facility. These eConsults should be given priority.
If you think that a case is too complex to be dealt with by chart review alone, do not hesitate to say so! If a patient should be transferred to John Cochran, you can recommend this in your note and call the referring provider, who is responsible for arranging the transfer to the appropriate service (usually Medicine). If you think they should be seen in the outpatient clinic, discuss with your attending whether to complete the eConsult or convert it to an outpatient consult.

EConsults are tracked depending on the time you spend reviewing the chart. Be sure to note approximately how long it took you to review the case at the end of the note. (See pages 22-23 and 26 for details.)

Outpatient Clinic

The Infectious Diseases service has three afternoon clinics: Monday PM (Dr. McDonald and the HIV Fellow), Tuesday PM (Dr. George and Dr. Lusk) and Wednesday PM (ID Fellow and Resident, all attendings except Dr. McDonald). These are held on 8-South and begin at 1pm. The ID fellow will participate in the Wednesday clinic, seeing 3-4 patients at each clinic. The ID fellow’s clinic room will have a sheet saying “ID Fellow” on the chart holder outside the door. When patients are ready to be seen, the med tech or nurse will bring the chart to you or put it in the chart holder outside the door. Patients can be staffed with any available attending, though it is preferable to staff patients with the attending they’ve seen previously. A patient may prefer to see a certain attending, and their request should be honored whenever possible.

To arrange a follow-up appointment, click on the Orders tab in CPRS, and in the left-hand menu, select “General (Outpatient)”, then “RTC/Clinically Indicated Date” from the pop-up box. In the order box, select “JC-PACT ID” as the clinic, pick the date you wish them to return, and put the “NLT Time Sensitive Appointment?” field as “No”. Then submit and sign the order.

Vaccines can be administered in the outpatient clinic, and most common ones are available right on the floor. When you have completed your visit with the patient, have them wait in the waiting room,
then inform the nurse or med tech of the vaccines you wish to be given and hand them the patient’s folder. Place a text order in CPRS stating the vaccines you want (e.g., “Give Tdap x 1”) and sign.

An ID pharmacist or pharmacy resident is available for each clinic, usually seated in the office next door to the ID fellow. Do not hesitate to ask them any questions you may have about medication choice, dosing or interactions! The pharmacist can speak directly with the patient about any medications of concern. If you’re having administrative or technical issues with getting medication to a patient, they are also your best point of contact. If you make changes to any home IV antibiotic regimen or stop home IV at a clinic appointment, let them know so they can coordinate the follow-up care.

**OUTPATIENT PARENTERAL ANTIBiotic THERAPY (OPAT)**

The OPAT service, informally known as the Home IV service, allows patients to receive IV antibiotics at home for both shorter and longer durations. You will often receive calls regarding home IV patients and management of their antibiotics or administrative issues. You may also be added as a co-signer on the ID Pharmacy notes for these patients. When there are questions about managing home IV services, do not hesitate to ask the ID Pharmacists or your attending for assistance.

**JC Inpatients**

For patients who are inpatient at JC, the primary team should submit the consults for home IV antibiotics. These are found in the Consult Order Menu under “Home IV” or “Non VA Care”. These both go to the “Non VA Care” menu, where they should select the “Non VA Care GEC Home IV Therapy Outpt STL” consult, in the “Non VA Care Extended Care and Rehab” section in the outpatient column!

```
NON VA CARE EXTENDED CARE AND REHAB
  NON VA CARE GEC
    Non VA Care GEC Adult Day Care Outpatient STL
    Non VA Care GEC Community Nursing Home Outpt STL
    Non VA Care GEC Home IV Therapy Outpt STL
    Non VA Care GEC Hospice Home Outpatient STL
    Non VA Care GEC Nonskilled Homemaker Outpatient STL
    Non VA Care GEC Respite Home Outpatient STL
    Non VA Care GEC Skilled Home Health Care Outpatient STL
    Non VA Care GEC Veteran Directed Outpt STL
  NON VA CARE REHAB
    Non VA Care GEC Adult Day Care Outpt STL
    Non VA Care GEC Community Nursing Home Outpt STL
    Non VA Care GEC Home IV Therapy Outpt STL
    Non VA Care GEC Hospice Home Outpt STL
    Non VA Care GEC Nonskilled Homemaker Outpt STL
    Non VA Care GEC Respite Home Outpt STL
    Non VA Care GEC Skilled Home Health Care Outpt STL
    Non VA Care GEC Veteran Directed Outpt STL
```

This will then open a series of four consults. They must complete each one and submit them all. Some medications also require a Prosthetics Consult for an IV pole or CADD pump. These can be delivered by Prosthetics to the patient’s room once the consult is placed. Ask ID Pharmacy if you’re not sure which is needed, and let the primary team know.

You will now need to comment on two of the consults placed. One should come up in your CPRS list, titled “ID HOME IV ANTIBIOTIC”. The other will go to Pharmacy; they will usually send you an alert asking you to comment. **These should be dealt with ASAP, as the patient’s discharge often**
depends on it! On each consult, go to the Consult Tab → Action → Add Comment, and enter the following information:

- Antibiotics to be given at home (e.g., “Vancomycin 1.25g IV BID and Metronidazole 500mg PO q8h)
- Antibiotic Start Date
- Antibiotic Duration (can say, “through next ID appointment” if you’re not sure, though you should also give an approximately duration)
- Labs you would like drawn and how often
- When ID follow-up will be (or if no ID follow-up is needed, state this)

Patients that are assigned to the Marion or Poplar Bluff VAs do not get home IV therapy through St. Louis, but rather through their own VA, even if they are inpatient at JC. If you have a patient from these VAs, ask your attending or the ID Pharmacists about how to arrange home IV services in these locations.

<table>
<thead>
<tr>
<th>Antimicrobial Agent</th>
<th>Frequency of Laboratory Testing per Week</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>CBC</td>
</tr>
<tr>
<td>Beta-lactams</td>
<td></td>
</tr>
<tr>
<td>Oxacillin, Nafcillin</td>
<td>Once</td>
</tr>
<tr>
<td>Ampicillin/Sulbactam</td>
<td>Once</td>
</tr>
<tr>
<td>Piperacillin/Tazobactam</td>
<td>Once</td>
</tr>
<tr>
<td>Cefazolin</td>
<td>Once</td>
</tr>
<tr>
<td>Ceftriaxone</td>
<td>Once</td>
</tr>
<tr>
<td>Cefepime</td>
<td>Once</td>
</tr>
<tr>
<td>Carbapenems</td>
<td>Once</td>
</tr>
<tr>
<td>Aztreonam</td>
<td>Once</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>Aminoglycosides</td>
<td>Once</td>
</tr>
<tr>
<td>High-Dose TMP/SMZ</td>
<td>Once</td>
</tr>
<tr>
<td>Vancomycin</td>
<td>Once</td>
</tr>
<tr>
<td>Linezolid</td>
<td>Once</td>
</tr>
<tr>
<td>Clindamycin</td>
<td>Once</td>
</tr>
<tr>
<td>Daptomycin</td>
<td>Once</td>
</tr>
<tr>
<td>Tigecycline</td>
<td>Once</td>
</tr>
<tr>
<td><strong>Quinolones</strong></td>
<td></td>
</tr>
<tr>
<td>Ciprofloxacin</td>
<td></td>
</tr>
<tr>
<td>Moxifloxacin</td>
<td></td>
</tr>
<tr>
<td><strong>Antifungals</strong></td>
<td></td>
</tr>
<tr>
<td>Amphotericin</td>
<td>Once</td>
</tr>
<tr>
<td>Echinocandins</td>
<td>Once</td>
</tr>
<tr>
<td>Azole antifungals</td>
<td>Once</td>
</tr>
<tr>
<td>Antimicrobial Agent</td>
<td>CBC</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Acyclovir</td>
<td>Once</td>
</tr>
<tr>
<td>Ganciclovir</td>
<td>Twice</td>
</tr>
<tr>
<td>Foscarnet</td>
<td>Once</td>
</tr>
<tr>
<td>Cidofovir</td>
<td>Once</td>
</tr>
</tbody>
</table>


Outside Hospital Inpatients
If a patient is at an outside hospital and you receive a call asking to set up home IV antibiotics, tell the caller that the medical team from the outside hospital must contact the VA Medicine Chief Resident through the hospital operator and arrange for a transfer to our VA. Often, these requests will come from discharge planners or case managers at outside hospitals. In the interest of patient safety, the infectious diseases service requests that these patients be transferred from the outside hospital to JC to safely evaluate and initiate the OPAT process. Although it used to be true that this could be done on an outpatient basis, this is no longer the case due to patient safety issues. If you run into problems with this (e.g., patient has an LVAD and can’t be transferred), discuss the case with your attending and/or the ID Pharmacists.

Outpatients
For patients you see in clinic that need to start home IV therapy, place the home IV consults as outlined above. In addition, place an AETC consult (Consult Menu → AETC/ASE Nursing JC). The AETC is our “day hospital” unit on 4-North, where patients can be admitted for a short time to get the first doses of their antibiotics. Choose with your patient a date and time you would like the patient to be admitted to the AETC – out of courtesy, try to submit the consults at least 48 hours before the patient is going to show up! Also order all of the antibiotics you would like given at the AETC visit as “on call” orders. (Orders → Meds, Inpatient → under “Schedule”, select “on call”, and place a note “for AETC administration on XX/XX/XXXX” in the “Comments” box.) For the Prosthetics consult, you can specify that the equipment should be delivered to the AETC on the specific day and time of the patient’s AETC appointment.

ANTIBIOTIC APPROVAL

For detailed information on antibiotic approvals and antibiotic stewardship, refer to the VA Infectious Diseases Handbook

The coverage for antibiotic approvals is provided during daytime hours by the Clinical Pharmacy service. ID fellows are responsible for the evening hours. For inpatients, the primary team is responsible for submitting the orders and necessary consults. If they are uncertain how to do this, refer them to the VA Infectious Diseases Handbook. To provide approval of an antibiotic after hours, simply call the pharmacy (56339), state that you’re the ID fellow on call, and provide them the information on the patient, drug, dose and duration that you’ve approved.

The schedule for coverage of antibiotic approvals is as follows:
Both dalbavancin and oritavancin require approval for initiation in the ED regardless of the time of day, so you may receive a call from the ED overnight requesting approval. There is a specific order set (located in Consults → Pharmacy → Outpatient Pharmacy Consults → Outpt (Oritavancin ED Order Set)) that must be submitted by the ED. The order set consists of a consult for the drug, and an outpatient ID consult. The ID service would like to follow-up with all patients receiving lipoglycopeptides 2-7 days after the medication has been administered, so please let the schedulers know about the patient the next day so they can arrange this.

**PATIENT PHONE CALLS**

A phone call with a patient is considered a patient visit in the VA system. Therefore, if you spend more than 5 minutes speaking with a patient, a brief note should generally be completed in the chart. There are no set requirements for the note – document what is clinically or administratively relevant to you. The process for entering the note and encounter in CPRS is outlined below.

**HOW TO WRITE A NOTE IN CPRS**

1. Open the patient’s chart. In the upper left will be a gray box with information on the patient’s location. If no location is selected, it will say “Visit Not Selected”. Click on that box.

2. A window will appear where you can choose a visit type. Click on the “New Visit” tab, and in the “Visit Location” box, enter the visit location you want. The visit location choice is important for us to get appropriate credit for our work, so make sure you choose the right visit! The visit you want is dependent upon what type of patient you’re seeing or what type of note you’re writing. They are as follows:
   - Inpatient Consult or Progress Note: JC-PACT ID INPT-X
   - Other inpatient notes or any progress notes that won’t be staffed by an attending: Don’t change the visit, simply write your note under the inpatient visit.
3. **Do not start your note until you have selected a visit.** If you make a mistake with the visit choice, you have to copy your note text, delete the note, create a new visit, then make a new note and paste your text back in. Once you’ve signed the note, there’s no changing the visit, so make sure you’ve got it right!

4. To start a note, go to Action → New Progress Note. A box will appear asking you for the Progress Note Title and the expected note co-signer. You are the “Author”, choose your attending as the co-signer. (For clinic notes, put the person you expect to staff with; this can be changed later.) If there is an associated consult, click on that consult to link it to the note.

For the progress note title, this again depends on the type of note and visit. It is not as essential to get this perfectly, as you can change it before you sign your note, but do try to be accurate. Type “Infectious” into the box to see the list of potential notes. Select the right note as follows:

- Inpatient and Outpatient Initial Consult Notes: INFECTIOUS DISEASE CONSULT STL
5. If you are doing an eConsult, a special note format will appear to fill out. You will be able to change this text after you click “OK”, so just write what you’ve got.
6. If you are not doing an eConsult, a big white space will appear on the right side of the screen. This is your note. It is a basic text editor. You are able to cut, paste and copy into and out of this screen as needed. If you accidentally log off CPRS or switch to another patient’s chart, the note and its text are automatically saved. To work on a previously saved note, select the note, then go to Action → Edit Progress Note, and the note should open for you to edit.

7. To change the note type or the co-signer, click on the “Change” button in the upper right hand corner right above the text editing window. This will bring up the same window as before to select the note title and co-signer, or to link a consult request to the note.

8. Before signing your note, make sure the Visit and the Co-signer for the note are correct. This information may no longer be in the gray box, but will be displayed above the note text editor. If you need to change either of these, refer to the instructions above.
9. Once you have finished with your note and are ready to sign, go to Action → Sign Note Now. If you are doing an inpatient consult or progress note staffed by an attending, an electronic consult, an outpatient consult or progress note, or a patient phone note, a box should pop up asking if you are the primary provider OR asking you if you want to enter encounter information. **If you are writing one of these notes and this box does not appear, you have done something wrong! Ask for help or review the instructions above.**

10. If you get the box asking if you are the primary provider, click “No”.

11. If you get the box asking if you would like to enter encounter information, click “Yes” and proceed to the next section on entering encounters. Click “No” if the attending prefers to enter their own encounters.

12. Once you have finished the encounter (or clicked “No”), a box will pop up asking you for your signature code. This is usually your PIV PIN unless you chose a different signature code at some point. Type it in and press OK. If you do not wish to sign the note, click cancel, and your note will be saved unsigned.

**HOW TO ENTER ENCOUNTERS IN CPRS**

1. If you are signing your note, you will be prompted automatically to enter an encounter when it’s needed. Encounters are needed for the following note/visit types:
   - Inpatient Consult or Progress Note: JC-PACT ID INPT-X
   - Electronic Consults: JC-ID E-CONSULT
   - Outpatient Consult or Progress Notes: JC-PACT ID
   - Patient Phone Notes: JC-PHONE INF DISEASES-X

   **If you are writing one of these notes and this box does not appear, you have done something wrong! Ask for help or review the instructions above.** Progress notes for inpatients that won’t be seen by an attending or other miscellaneous notes not involving a patient visit, phone call or eConsult do not need an encounter.

2. If you want to enter an encounter at other times, or edit the encounter, select your note from the list, then go to the Notes tab, and click on the gray “Encounter” bar in the lower left corner.
3. A box will pop up asking if you want to enter a new encounter, or to edit the encounter for the note. Click on the “Edit Note Encounter” button.

4. The encounter window will pop up. What is displayed in this window will depend on the visit type. For regular inpatient and outpatient visits, you will see the same window, shown below. Select the Type of Visit first:

- New Outpatient Consult: OUTPATIENT/NEW
- New Inpatient Consult: INPATIENT/INITIAL CONSULTATION
- Established Outpatient: OUTPATIENT/ESTABLISHED
- Inpatient Progress Note: INPATIENT/SUBSEQUENT DAY

The other types of visits are not used by our service.
5. After you have selected the visit type, you will be asked to choose a billing category under the “Section Name” box. You will get a separate brochure that details how to choose the right category.

6. For electronic consults, a different box is shown. In the “Section Name” Box, select the amount of time it took for you to complete the consult.
7. For Patient Phone encounters, these two boxes should be blank.

8. At the bottom half of the window, on the right side, it lists current providers. If your ID attending’s name is not in that box, find their name in the list on the left, then double click to add it to the current providers list. Highlight their name on the list, and click the “Primary” button to make them the primary provider. It should now say “(Primary)” after their name.

![Current providers for this encounter](image)

9. Go to the “Diagnoses” tab at the top. You can select your diagnoses from the available list, or click on the “Other Diagnosis” button to find the diagnosis you’re looking for. List the diagnoses that are applicable to your patient, but you don’t have to go crazy. If it’s one, then that’s perfectly fine for non-complex patients. If you have more problems you are addressing in your note and in your care, choose the main ones. 3-4 diagnoses are the most you should need to enter.

10. If you are doing a Phone note, it is often helpful to choose from the “TELEPHONE DIAGNOSES” list for your diagnostic codes.

11. If you are doing a Phone note or eConsult, go to the Procedures tab. For an eConsult, check the time it took to complete the consult once again. If you spoke to or e-mailed with the referring provider directly, click on the “INTERPROF PHONE/INTERNET” in the “Procedure Section” box, then select the appropriate amount of time you interacted with the referring provider.

![Encounter Form for JC-ID E-CONSULT](image)

12. Click “OK”, and you’re done! If a box pops back up saying there’s missing information, don’t worry about it, as it’s probably referring to the service-connected conditions. You do not need to fill those out.
**Finding Stuff in CPRS and Elsewhere**

**Antibiogram:**
In the Menu bar, Tools → Pharmacy → Antibiotics. Basic ones are also available in the VA Infectious Diseases Handbook.

**Biopsy Orders:**
Orders tab → Imaging Procedures. Choose the appropriate list (outpatient or inpatient), then → Interventional Radiology → Interventional Radiography → CT BIOPSIES/DRAINAGES/CYST ASPIRATIONS.IC (lower left of the menu).

**EKGs:**
To view, in the Menu Bar, Tools → VistA Imaging (you may need to sign in with your CPRS login again). Click on the red QRS complex button. To order, go to the Cardiology Consult menu. EKGs are done on the 2nd floor at the Heart Station across from the lab. The patient can go there at any time during business hours.

**HIV Genotype:**
Generally in one of three places: A previous ID note, VistA Imaging, or in a Lab consult. To look for a genotype in a lab consult, go to the “Consults” tab, then View → All Consults. Scroll down the list looking for a “FEE-BASED LAB” or “NON VA CARE LAB” consult. If you find one that is supposed to have a genotype, but there’s no note of a genotype in the consult comments, check VistA Imaging for the report.

**Immunizations:**
Reports tab → Health Summary in the left-hand menu → Immunizations/Skin Tests

**Medication Administration:**
In the Meds tab, double click on the name of the inpatient medication and scroll down.

**Medication Lists:**
Reports tab → Clinical Reports in the left-hand menu → Pharmacy → All Medications. You can then choose how far you want to go back, sort by name or date, etc.

**Pharmacy Anti-Infective Prior Approval Consult:**
Consult menu → Pharmacy
If inpatient → Prior Approval Inpt (ANTI-INFECTIVE)
If outpatient → Outpt (ANTI-INFECTIVE)

**Primary Care Reminders:**
Need to review for HIV-positive clinic patients. A list of reminders is on the Cover Sheet tab, or can be seen by clicking on the red alarm clock in the upper right hand corner. To fill out a reminder, open a new note, then click on the grey “reminder” bar that appears in the lower left hand corner of the Notes tab.

**Vital Signs for ICU Patients:**
Open a Remote Desktop Connection. In the “Computer” box, type “VHASTLICCARDFARM”, and click “Connect”. Enter your PIV PIN. If they ask about certificate errors, click “Yes” to continue. A “Government Computer” message will pop up. Click OK. The system
will likely say that it cannot log you on. Click OK. A screen should now appear asking you for your PIV PIN again. Enter your PIN and click “OK”. A desktop should appear. Click the “ICCA” shortcut. It will ask you for an Access Code and Verify Code – these are the same as for CPRS. Enter them and press OK. You should now be logged in!

Common Lab Tests and CPRS

<table>
<thead>
<tr>
<th>What You’re Looking For…</th>
<th>What It’s Called in CPRS…</th>
</tr>
</thead>
<tbody>
<tr>
<td>CD4 Count</td>
<td>T-Helper/Suppressor Panel</td>
</tr>
<tr>
<td></td>
<td>In Common Labs Menu: CD4 CD8</td>
</tr>
<tr>
<td>Cholesterol and Triglycerides</td>
<td>Lipid Panel</td>
</tr>
<tr>
<td>Erythrocyte Sedimentation Rate (ESR)</td>
<td>Sed Rat</td>
</tr>
<tr>
<td>Hemoglobin A1c</td>
<td>HgA1c or A1c</td>
</tr>
<tr>
<td></td>
<td>In Common Labs Menu: A1c</td>
</tr>
<tr>
<td>HIV Genotype</td>
<td>Has to be ordered as a send-out (See Non VA Care Consult menu for “Lab and Path”). Send copy of consult with patient to lab</td>
</tr>
<tr>
<td>Meningitis Panel</td>
<td>Meningitis/Encephalitis PCR Panel</td>
</tr>
<tr>
<td>Respiratory Virus Panel</td>
<td>Respiratory PCR Panel</td>
</tr>
<tr>
<td>Tuberculosis Interferon-gamma Release Assay</td>
<td>Quantiferon-TB Gold</td>
</tr>
<tr>
<td>Urine Drug Screen</td>
<td>Limited: UDS</td>
</tr>
<tr>
<td></td>
<td>For narcotics patients: Methadone Panel</td>
</tr>
<tr>
<td>Urine Gonorrhea and Chlamydia</td>
<td>GC &amp; Chlamydia PCR (Throat and Rectal PCR as send-out only; Can also send separate Gonorrhea culture)</td>
</tr>
</tbody>
</table>

**IMPORTANT CONTACTS**

**Most important numbers will be at the top of your ID Daily List!**

John Cochran VA Main Number: (314) 652-4100 – dial the five-digit extension after the tone
John Cochran Address:
915 N. Grand Blvd
Saint Louis, MO 63106

Medicine Office Fax Machine: (314) 289-6389 (x56389 for in-house faxes)
OPAT Fax Machine (OPAT Labs ONLY): (314) 289-7688

Attending Office Numbers and E-mails:
Dr. Abigail Carlson       B602B           Abigail.Carlson@va.gov
Dr. James Fleckenstein   B633            jflecken@wustl.edu
Dr. Sarah George         --              georgesl@slu.edu
Dr. Geoffrey Gorse       --              gorsegj@slu.edu
Dr. Rodney Lusk:         B635            Rodney.Lusk@va.gov
Dr. Jay McDonald         B604            Jay.McDonald1@va.gov
All Primary Team contact information is available on the On Call Intranet Website:
https://vaww.visn15.portal.va.gov/stl/SiteDirectory/has/stloncall/onCallView.aspx

The St. Louis VA Phone Directory is at:
http://v hastlwebdata1.v15.med.va.gov/phone/lib_staff.php

ID Clinic Numbers:
  Scheduling (Courtney Allen): x53406
  Non-Emergency Number for Patients: x53370

Selected ID/HIV Web Resources:
IDSA Practice Guidelines
http://www.idsociety.org/IDSA_Practice_Guidelines/

HIV/AIDS Guidelines and Patient Information
http://www.aidsinfo.nih.gov/

Sexually Transmitted Diseases CDC Treatment Guidelines:
https://www.cdc.gov/std/tg2015/default.htm

CDC Travel Medicine Recommendations
https://wwwnc.cdc.gov/travel/

AHRQ Guideline Clearinghouse
http://www.guideline.gov/

SHEA Infection Prevention/Antimicrobial Stewardship Guidelines:
http://shea-online.org/index.php/practice-resources

Clinical Infectious Diseases Home Page:
https://academic.oup.com/cid

Emerging Infectious Diseases Home Page:
https://wwwnc.cdc.gov/eid/

MMWR: Morbidity and Mortality Weekly Report
http://www.cdc.gov/mmwr/

World Health Organization Infectious Diseases
http://www.who.int/topics/infectious_diseases/en/

HIV and Hepatitis site with resources for the clinician:
http://www.hivandhepatitis.com

Comprehensive online resource on HIV:
http://clinicaloptions.com/HIV.aspx